DARLENE MCLENNAN: Afternoon everybody. Welcome to the ADCET webinar on How to Structure Documents Correctly. Before I begin I would like to pay my respects to the traditional and original custodians of the land I’m on today, the palawa people and pay respect to elder’s past, present and emerging. I would also like to acknowledge the Tasmanian Aboriginal community who continue to maintain their identity, culture and Aboriginal rights. Thank you for joining us today, my name is Darlene McLennan and we’re excited to be able to offer this presentation to you today on how to structure documents correctly. Working in the sector for over 14 or 15 years it still frustrates me that we as a sector often don’t do this well and I’m really excited that we actually have the opportunity to hear from our presenter Andrew Downing about how to do this better because I think all of us can improve our practice. Andrew, if you’ve read his bio on our website, has worked for many years in the VET sector in providing information to staff and students on adaptive technology. We’ve been very fortunate at ADCET to have Andrew be working for us in the last couple of months to actually produce some How To videos which we hope to launch soon and also doing this webinar. You can see on your screen now is a little bit of how to set up Zoom if you need but I’ll just go through some things. If you want to activate closed captioning you click on the CC button on the toolbar. This is located either on the top or bottom of your screen. To increase the number of lines appearing in the caption box you click on the small arrow at the top right side of the caption box. If you have any technical issues throughout the webinar, you can contact us on admin@ADCET.edu.au, that’s admin@ADCET.edu.au. The presentation will run for around 50 or so minutes and we’ll have 10 or so minutes for questions at the end. Throughout Andrew’s presentation, please feel free to put your questions into the chat pod or into the question pod. If you’re wanting to have a conversation with other people you can actually choose the entire audience by selecting all panel and attendees and previous webinars people have actually been able to answer each other, put links that might be discussed into the chat pod. So that’s been quite an interactive process for this webinar. Andrew’s happy if there’s any confusion throughout the webinar for me to jump in and ask him some clarification questions if someone has asked for clarification throughout the presentation. So we will do that. But otherwise, yeah, the questions will be asked at the end. I think that’s all. Sit back, enjoy the webinar. Hopefully at the end of the hour you will feel a lot more wiser as I will. So over to you, Andrew. Thank you very much.
ANDREW DOWNING: Thanks, Darlene. Good afternoon all, or good morning or good evening, depending where you are in the world. That’s one of the things I love about this technology, we can talk to people all over the place. Now you may think this is a pretty dry old subject but let me assure you that after an hour you are going to have a whole new perspective on life, the universe and everything, well at least when it comes to structuring documents. So what we going to look at - the first thing I want to get across is that correct document structure and accessibility are not hard to do. In fact, one of the things I want to get across is that if you know how to structure documents correctly you will save yourself a huge amount of time and effort which I will stress during the presentation. I’ll be focusing on Microsoft Word but the principles I’ll be discussing are relevant to other formats. I’m going ‑- just apologies in advance when I do cough, my throat is a bit less than optimal at the moment. I’ll do my best not to splutter though. I want to say a little bit about writing meaningful alternative text for images and I’m hoping I will have time at the end to look at converting from Word documents to accessible PDF documents.
Benefits of Structured Documents. Consistent appearance within the document and between documents saves much time and effort, I told you I’d say that, saves much time and effort both when creating the document and when editing later. That allows easy creation of accessible PDF files, DAISY and ePub books, hardcopy Braille material and XML files. I’m now going to show you two documents. Have a look at that file. Now have a look at this file. And unless you’re very keen, you won’t pick much difference between them. But the first one, this one, is unstructured and this one is structured. So back to our unstructured one. Though I’m using the screen reader for my own purposes here because I’m blind but I’m going to let you hear the screen reader from time to time during the presentation including right now. So I’m going to get the screen reader to read this unstructured document to you, or just a little bit of it, and then we’ll go to the structured document.
SCREEN READER: To create a well-structured file -
ANDREW: Let’s go to the top
SCREEN READER: ‑ sample structured file. Using styles to create a well‑structured file it is important to use formal styles. That is do not just adjust font size and style to get the appearance you want.
ANDREW: So we’ll leave that there. Now I’m going to the structured document and you’ll hear that the screen reader provides me with a lot more information.
SCREEN READER: Heading level 1 sample structured file. Heading level 2, style heading 2, using styles. Style normal, to create a well-structured file, it is important to use formal styles. That is, do not just adjust font size and style to get the appearance you want.
ANDREW: So there you heard the screen reader announcing the type of style that was being used - heading 1, heading 2 and then normal. That is not just for screen reader users that structuring is important. If I turn on the navigation pane, which I will do by going to the View menu. I’m going to check the Navigation Pane. Now this allows me to navigate the document. So I can go to Using Styles, Tables - if I hit Enter on that, it then drops me on to the tables, the tables heading. Now on a one‑page document that’s not terribly important but for a large document it is really important. Another benefit of structuring is that if you’ve done your document well, you can then very easily create a Table of Contents. Word will do all that work for you. Whereas if you don’t structure it, if you just make it look the way you want it to by adjusting font and paragraph spacing and so forth, then that won’t work.
Hierarchical headings. A level 2 heading follows a level 1. A level 3 follows a level 2, etc. Don’t skip heading levels. So don’t jump from a level 1 to a level 3 heading. It’s important that the visual appearance matches the level of the heading. I have come across cases where a level 3 heading has a bigger font than a level 2 and that’s really quite silly because the idea of using hierarchical headings is that it sets up the structure of the document. So the chapter might start with a level 1 heading and then subsections within the chapter would be a level 2 and if you go further down a level 3. Just as you visually would look at the size of the text and know what that means, screen reader use the heading level to know how the document is structured. A bit more about hierarchical headings, now this applies specifically to Word but it is well worth knowing. So you can select your heading levels and all your other styles with the mouse but you can also do it from the keyboard. I’m a bit of a keyboard fan but whatever works for you. Ctrl‑alt‑1 gives you a level 1 heading, ctrl‑alt‑2 for a level 2 and ctrl‑alt‑3 for a level 3. Word doesn’t go any further than that with its default layout, but shift‑alt‑right arrow will take it down another level if you really must have your documents that complicated. And shift‑alt‑left arrow brings it up a level. The other important one, shift‑ctrl‑n gives you a normal paragraph. Let’s jump back to our structured document. I’m on the level 1 heading. If I press ctrl‑alt‑3 it’s suddenly turned into a level 3 heading. Shift‑ctrl-n, it’s now a normal style. Let’s put it back to where it should be. So it makes it very quick and easy to set up your document and as you’re writing the document. If you want another heading, you just press the appropriate key combination or select it from the Home tab of the ribbon as you wish and there’s the style applied.
Making paragraphs look just so and most of you will probably know this. You can either right-click in the paragraph or use the application key if your keyboard has one. The application key is that very useful key just to the left of the right control key, if your keyboard has one. Another option is if your keyboard, and some don’t these days, if it doesn’t have an application key, shift‑F10 will do it. So for the paragraph you can adjust the space before and after the paragraph, you can adjust the amount of indent, you can adjust the hanging indent. Don’t use multiple Enter presses to create the space between your paragraphs. That’s very uncool. For the font you can adjust the font size, style and colour. So let’s have a look at our document again. I’m going to select this whole paragraph, there’s a few ways of doing that, I just press the F8 key four times. Now I’m pressing the Application key. Let’s go to the paragraph. Now there’s quite a few settings. I’m not going to adjust very much but what I will do; I’m going to adjust the spacing after it from 12 points to 18 points. You might have noticed I have a zero point gap at the top of the paragraph. Some people like to have, say, six above and six below. I find it easier to calculate by doing it this way but again, it’s up to you. So now I’ve increased the spacing after this particular paragraph. I’m going to press the application key again, go to font, and I’ll just increase the size from 12 to 14. So that’s adjusted that paragraph for the moment. I’m going to leave that there and we’ll come back to it in a moment.
[pause]
But now we get to the really important bit of modifying and creating styles. You can either select styles from the Home tab on the ribbon or you can open the styles toolbar with this rather complicated key combination of ctrl‑alt-shift‑s. One of the things you can do, and I’ll show you in a moment, is to select Update Style and that updates all instances of the particular style that you’re focused on throughout the document and that’s really important. So if you have a document that someone needs slightly larger or smaller or a different colour or whatever font, rather than having to completely redo the document you can do all your normal paragraphs in one hit and then you’d have to go back and do your headings and so forth. But that’s much better than having to reformat the whole document. You can save the selection as a new style and if you’re going to use that appearance throughout your document, or even if you’re only going to use it once, it is really good practice to create a style. Don’t just leave it as the normal style like I’ve done back there a while ago. Let’s come back to our document. I’m going to press this complicated keyboard combination, ctrl-alt-shift-s and that opens the styles toolbar. So I’m on the normal style. I can arrow to other styles. Before I do anything with that I just want to show you a couple of settings in options. Now, select styles to show, Word says as recommended. I don’t like their recommendations much. You can show in the current document or all styles. For the moment I’ll choose in current document and the sort order they say is recommended, which again I don’t like, but you might. I’m going to select by type because that’s essentially alphabetical order and for my brain that actually works better. We’ll OK that and that drops us back to the document. So we’ll come back to our toolbar. Now, if I hit Enter on that button there, that would create the normal style, which is what it is already. So if I hit Enter on figure, which is where I am now, that would create the figure style. But what I’m going to do is to press the application key. Again, you can right click or use shift‑F10. This updates normal to match selection. What I didn’t mention, F6 and shift‑F6 moves you between the various open panes in your Word document. So now, this paragraph has the increased font, as does the paragraph about tables. So every normal paragraph is now bigger with more spacing after it and that doesn’t matter if it’s a one‑page document or a 500‑page document and that’s really important. I’ve covered this one, I think, already. Yes, there are many more options that you can look at in that toolbar that I didn’t show you but you can look through them at your leisure. One important one is whether you want to save the style in this document only or in all documents. If it’s a style that you are really only going to use once, then in this document’s fine. But if, like me, you don’t really like the default layout or the default appearance of the styles that Microsoft offers you can change to say your heading 1, heading 2 levels and you can then save them so the next time you open a document it will be the way you like it to be. And then, in that case you would choose in all documents based on this template.
Creating lists. As you might expect, we use specific styles for lists but Word makes it quite easy for you. So to create a bulleted list easily, just press the asterisk key followed by the tab or perhaps the spacebar, but the tabs probably safer. Write your first item, press Enter and the next bulleted item will appear. So the numbered lists is the same sort of thing. Push your number, number 1 is usually the best to start with, and you can use punctuation such as full stop, right parenthesis whatever and you can use letters if you want to do it that way as well. Let’s have a look at a document very quickly. This is going to be very exciting for you. I push the asterisk and the tab, first item. Now we have another bullet, second item, third item. Now if I press the Enter key twice at this point, that drops it back to a normal style. It’s just a convenient way of getting out of the list style. Despite what I said earlier, I’m putting an extra break in there just to break it up. I’m going to do 1, full stop, another first item. And there’s our second, etc. We’ll stop it at that. I think you get the point. There are options for allowing if you start another list you can continue numbering from where you were before or start again and all sorts. I’ll just delete all that and we’ll come back to our PowerPoint.
Creating tables. Use tables for displaying tabular data. I have a reasonably lenient view as to what is tabular data and some people are a bit more rigid. What you really shouldn’t use tables for is for laying out text on the page just so you can put the text where you want it because that will almost always mean that assistive technology will have real trouble knowing which order to present it to the reader and the reader will get very cross. You don’t want that. Create the table from the Insert tab of the ribbon. Don’t draw the table because if you do it won’t be accessible. Especially in Word, try not to create non-uniform tables, that is tables with merged cells. In HTML and in PDF, if you’re very clever, it is possible to use merge cells and code them so screen readers know what’s going on, but in Word, it’s not quite that good. Under properties in the Layout tab of the ribbon, uncheck ‘Allow Cells to Break Across Pages’. If you’ve got a lot of material in the cell, that might mean that you waste a lot of space on the page. But then you might need to consider whether you’re using the table appropriately anyway. Check ‘Repeat as Header Row at the Top of Each Page’ and I’ll show you this in a moment, don’t worry. And AutoFit to content I like because it just saves having to work out how big or small to make each cell on the table. Let’s go back to our blank document and I’ll insert a table. So we go to the Insert tab of the ribbon, it’s alt‑n if you want to use the keyboard command. We’re going to table and we can select the size of the table. I’ll make it 3x6. There’s our table with six rows and three columns. If you miscalculate and you want the table to be bigger or smaller, that’s quite easy to do. You can add rows, you can delete rows and columns and so forth. Word allows you to do that quite easily. Just excuse me a second.
[pause]
Okay, I’m now going to bring up a table which I’ve pre‑prepared. So as we say at the top there, the information in this table is completely fictitious. I made it all up. I’m going to let you hear the screen reader.
SCREEN READER: Table with 6 rows and 9 columns, level 1 row, one column, one style table grid.
ANDREW: So it told me that the table has six rows and nine columns. Now, there are specific keyboard screen reader commands to move around the table and it continues to frustrate me that a whole lot of screen reader users do not know them. 
SCREEN READER: Row 2 Monday
ANDREW: Now I’m on Monday. I’m going to go to the right.
SCREEN READER: Brisbane column 2, 20. Sydney column 3, 15. Canberra column 4, 10.
ANDREW: You’ll notice it’s announcing the column heading as well as the cell that I’m focused on and that’s because I have checked that repeaters header row at the top of each page. Even if the table doesn’t go over to a second page, it is still a useful thing to do. For some reason, when you check that, that tells the screen reader that it’s a column heading. What you can’t do in Word is to set it so that when I go down the column...
SCREEN READER: Row 3, 12. Row 4, 14.
ANDREW: You can’t automatically get it to announce the row heading. The screen readers do provide a facility for dealing with that. I’ll come back to the left.
SCREEN READER: Column 1, Wednesday. Row 2, Monday.
ANDREW: I’m going to press a command.
SCREEN READER: Set row 2, column 1 as start of row headers.
ANDREW: Now I’m going to go to the right.
SCREEN READER: Brisbane column 2, 20.
ANDREW: Now I’m going down the column.
SCREEN READER: Tuesday row 3, 19. Wednesday row 4, 23.
ANDREW: So now it’s announcing the row heading as well, which is quite important. The next thing I’m going to show you ‑- oh no, before I do that. I’m now on the top left cell of the table. I’m pressing the application key, again you can right click in the cell. I’m going up to table properties. We’re on the Table tab. We’ll go to the Row tab and this is where ‑- so you see I don’t allow rows to break across pages. And ‘Repeat as header row at the top of each page’ is checked which, as I say is important and worth doing. Now the next thing I’m going to show you though -- I’ll just escape out of that -- is a little bit esoteric in that it only applies to Office 365. If you’re still using Office 2016 or earlier, you won’t have this facility. As I say, it’s a bit esoteric but I’ll show it to you quickly. I’m going to go to the ribbon and going all the way across.
[pause]
I’ve come across to table two, as I say it will only be in Office 365 so the special formatting for the header row, that is checked. Total row is not checked. You could check it if you wanted to. Banded rows, you could or may not, just depends on what you want to do visually. First column is not checked. If I check that what will happen, if I converted this document to PDF, and I’ll show you how to do that towards the end using the save as dialog, that left column will then be marked up correctly so that in the PDF the screen reader would read that as row headings. I hope that wasn’t too complicated for you. Let’s go back to the PowerPoint. I’ve already discussed this one.
Inserting images. Select the image from the Illustration group ‑- ah, start again. Select the image from the Illustration group on the Insert tab of the ribbon. Do not paste the image if you want it to be accessible to screen readers because if you paste it, it won’t be. Provide meaningful alternative text. We’ll say a bit more about that in a little while. To do that, you right click the image. In Office 365, you go to ‘Edit alt text’. In earlier versions they kept moving it around. It’s either under format picture or size and something else. They keep moving it. Now, I’ve said depending on settings, but, again, this specifically applies to Office 365. In Office 365, if you’re connected to the Internet and you’ve turned the feature on, it will automatically provide a description of the image. As you will see, it won’t be terribly accurate. But at least it gives me, as a blind user, some idea about what the picture is. And it’s a start. So let’s go to our blank document. Ah, yes, let me finish this. Alternative text should be meaningful in the context of surrounding text. So importantly, think about the reason you’ve put the image into the document. I’ll say a bit more about that in a moment. I’m going to the Insert tab of the ribbon. I’m going to pictures.
[pause]
I’ll have this one here called AD‑RD. I’ll give you a clue. My son’s name is Russell. 
[pause]
Now, Word has created a description of this image. I’ll let you hear what it says.
SCREEN READER: Graphic of a person riding a motorcycle down a dirt road. Description automatically generated, page 1, section...
ANDREW: Go away [laughs]. It’s persistent.
[pause]
I think I’ve stopped that from telling me how it wanted it. You can again right-click the image. I’m hoping this works, it doesn’t always work with screen readers. Or you can use the application key. So now I’ve come to ‘Edit alt text’. So I Enter on that. I don’t think it will let me do it. Sometimes it gets a bit fiddly so let’s just.... No, it’s just dropped me out. I’ll see if I can get back there very quickly.
[pause]
No, it won’t let me drop into it, which is a bit of a pain. It does happen occasionally. If it would have let me in there, I could have written another description. Which wouldn’t have been a person riding a motorcycle, it would have been two people standing in front of a motorcycle in a lovely scene with fields and mountains in the background etc. And again, as I said, it would depend on the reason you put that photograph in there, whether it was to talk about our trip or whether it was because you wanted to demonstrate safety gear or something else. 
[pause]
So, a bit more about writing alternative text. Ideally alt text conveys the same meaning as the image. That can sometimes be a challenge. Sometimes I would assert that it’s sometimes not possible. Particularly in an educational setting, it may well be that material that you’re presenting online if that information is to be conveyed effectively to someone with a print disability or someone who has a significant vision loss you may well be looking at raised line drawings, 3D printers, etc. So there are times where alt text just will not do the job. Wording depends on the context. I’ve mentioned that and that’s really important. Describe the scene rather than the image. If the image is a metaphor explain it. What is an appropriate length? Some people will argue for hours about this. My comment is while succinct, as long as necessary. When it shouldn’t include alt text, when purely for visual decoration. And some people take a fairly liberal view of what is decoration. I sometimes get emails from people like Microsoft, and they have quite nice alt text on their images, which is purely just to set the scene and to get me interested. But excited people playing with their ThinkPad or something or other, it’s a nice touch. Although, if there’s lots of images it can get a bit tedious so you need to have a think about that.
Creating Word templates. Templates save reinventing the wheel. If you’re going to be using the same format in lots of documents then create a template. To create the template, open a blank Word document, apply the styles and layouts that you want. Put some place holder text in there because that means that when you or someone else comes back to work on that document you know what should go into that particular section of the document. When you save the template, save it as a dotm file. The difference between the scene and the image. What some people are inclined to do, they’ll say photograph of a person and that doesn’t really tell me what the image is there for. What’s the person doing? Sorry, I missed that last question. Darlene will have to catch me up later.
DARLENE: Don’t worry about the questions. I’ll do that after, Andrew.
ANDREW: So, save as dotm and that will be one of the options that you get when you go to the ‘Save as type’.
Using Word templates. To use a template just open it in the normal way. Find the template in -‑ oh, when you save it make sure you know where you put it by the way. That can be a trap for young players. To use a template just, thank you, open the template, just double click it or Enter on it, however you normally open your Word files. Enter the required information and save as a docx file so that won’t overwrite your template. It will just create a new file and that’s a really nice way to work.
The MS Word accessibility checker. To use the accessibility checker, open the file menu, alt‑f. Select the information. Select ‘Check for issues’ and ‘Check accessibility’. A tab will appear with a report on any issues. Correct as necessary. The checker is useful but it is not infallible. I noticed recently I’d skipped a heading level and it didn’t rumble. So I did. An image marked as decorative in older versions of Word through an error. When I checked it on this version of Word the other day, it didn’t so it looks like they’ve fixed that one. Let’s come back to our original document and we’ll go to the File menu and that drops us onto information. I’ll tab across. So we go to inspect document and we arrow down to ‘Check for accessibility’. I probably should have created a file with more errors but never mind. So I’m using the F6 key to go across.
[pause]
Here we go. We’re over to our inspections. Now, it’s given me a warning about hard‑to‑read text. I’ve left that one there because that appears on a caption for a photograph which you may not have seen when I had the document open before. The reason I left it there is because I created the caption using the default Microsoft style for captions. So it’s their fault, not mine. He said, smugly. They created the problem in the first place and then blamed me for it. So if you wanted to, you would go back and ‑- and I don’t know why they call it a warning either. Perhaps they’re not completely convinced. I mean there are tools for checking colour contrast. That’s for another day. But maybe theirs isn’t as precise because there is a specific specification for the ratio between foreground and background colours.
Converting to a PDF.
[pause]
If Acrobat is installed, which it is on my computer, you can select the Acrobat tab from the ribbon. Select create PDF and the default settings will usually suffice. From the Word ‘Save as’ dialog, you can also create the PDF. That’s, these days, my preferred way of doing it. When I mentioned earlier about checking that left column in the table to show differently etc, etc. if you use the Acrobat option that won’t mark up properly whereas if you use the Word ‘Save as’ it does. Important to check in option that bookmarks and tags for accessibility are checked. Once you’ve converted to PDF, by the way, Acrobat has an accessibility checker. They keep moving it from version to version in different places. But it is quite thorough and gives you a very detailed report. Let’s come back to our document. I’m going to ‘Save as’. Now I’m going to use the F12 key. In later versions of Word, if you go to the File menu and ‘Save as’ then it wants to go through a whole lot of OneDrive options and all sorts of things. I’ve just tabbed across to the save as. Hit P for PDF, there on PDF now. I’m going to go to options. We won’t put any metadata in at the moment, although we should. Here’s our options. Now most of these are OK. So I’ve checked bookmarks there. If that wasn’t checked then you don’t get bookmarks in the document. If you’re not familiar with bookmarks in a PDF file, they are a really valuable navigational tool. You essentially get a tree view structure and that allows you to go through the document. It’s like a table of contents and it’s very, very effective so make sure that’s checked. That will convert headings into ‑- they call them bookmarks. It’s a strange term. Check ‘Document properties’. I’ve checked ‘tag for accessibility here’. It used to be the default seemed to be unchecked. It’s worth checking at least the first time, and probably most times, to make sure that it has remained checked. So I will use essentially the same name. So ‘Sample Structured’, I’ll hit Enter. Oh, I didn’t delete it before. Sorry about that. I’ll overwrite it. So now we have a PDF file which is fully accessible. I’ll let you hear a little bit of it.
SCREEN READER: Heading level one, Sample Structured File. Heading level two, Using styles. To create a well‑structured file it is important to use formal styles.
ANDREW: And if I go to the table.
SCREEN READER: No next table.
SPEAKER: It’s not on this document, sorry. It’s the wrong file.
SCREEN READER: Heading level 2 using styles. Page 2, blank, blank, no next table. Heading level 1, page 1, Sample Structured File.
ANDREW: That’s right, there is no table on this file. Sorry about that. Never mind. So I can jump from heading to heading very quickly.
SCREEN READER: Using styles, heading level 2. Table, heading level 2.
ANDREW: Etc. I’ll spare you any more of that. That’s the PDF. I might ‑ I won’t show you the bookmarks now, although it...
DARLENE: Sorry, Andrew, there’s just a text box on that sample structured file. So does that come up okay?
ANDREW: It’s not a text box, actually. 
DARLENE: Okay.
ANDREW: If we come back to the Word document. It’s a style that I applied when I was talking about text boxes.
DARLENE: Okay, I was worried it was a text box. I was thinking ‘oh no’.
ANDREW: No, I made it look like one but it’s not a text box. I wouldn’t do a thing like that.
DARLENE: I know, that’s what I was worried about.
ANDREW: Thanks for the pickup.
[pause]
PDFs are not all born equal. There are three general categories of PDF. Image‑only PDFs and this is what really gave PDFs a very bad name because people scanned paper documents into the PDF and they’re completely inaccessible unless you’ve got some sort of optical character recognition tool but that’s not equitable access so I’m not going to advocate that at all. Now of course, had PDFs not been invented, people would have scanned into Word documents and they would have got the bad rap instead, but anyway. There are unstructured PDFs. Had I not checked that check box that said ‘tag for accessibility’, it would have been unstructured. Had I printed to PDF it would have been unstructured. A lot of the desktop publishing software will produce unstructured PDFs and they can become a real menace to read with a screen reader or other assistive technology because the reading order goes out to lunch in a big way. Structured or tagged PDFs, they’re the ones that we want. So converting from Word to PDF, the way I showed you. As long as your Word document is done well, then you will get a good, useful PDF. Coming from other formats, as I mentioned, coming from InDesign, more knowledge is needed. In fact, yesterday I made the comment that coming from InDesign to make the document accessible, it seemed more like a dark art to me than it is a science. Some clever people know how to do it but it is a bit tricky. So thank you very much. I hope you are still awake. If we have any questions I’d be happy to answer them. Thanks Darlene.
DARLENE: Great, thank you very much. So we had a couple of questions, Andrew. Somebody asked what is the fastest way to find out if a document has been created using styles?
ANDREW: With a screen reader it’s very easy because it will tell you but in a normal Word document, if I come back to our Word document, up in the ribbon it should be showing you which style is ‑ it’s not my forte ‑ but that should be showing you which style is being used for a particular paragraph. Let me go back up the top. Somewhere up in the ribbon there, that should be showing you that the level 1 style is being applied. The other option of course, would be to go across to the toolbar.
JANE: It’s Jane here Andrew. If you can just go to your Home, select your Home tab and then we can see the ‑ yep, there we go. That’s Home now and then we can see the styles there.
ANDREW: OK, good.
JANE: The styles aren’t open at the moment but we’d be able to ‑
ANDREW: You can click on that and open it.
JANE: That’s right. We’d be able to mouse and open them then we’d be able to see that it’s heading 1 and heading 2.
ANDREW: Yep, which ‑ and it’s a very important point and thanks for asking the question because it’s important that you know particularly if you haven’t created the document, what’s been done to it. And, yeah, I’ve got my email and phone number there so if you do have questions by all means drop me an email, give me a call.
DARLENE: Yep, brilliant. A couple of people have had issues with trying to find alt tag, the alt tag...
ANDREW: For images?
DARLENE: Yeah, so I’ve kind of did a little bit of search while we were doing it and it might be one of those Google things if you haven’t...
ANDREW: Essentially, regardless of the version of Word, if you right-click the image then it should open the appropriate menu so that you can find it. As I said, though, they have moved it around. I think it’s under size or format picture.
DARLENE: And sometimes it’s actually under - is it the paint box? There might be an image of a paint box. I’ve gone to the new Word now. I can’t remember the old Word. But for the people that do have difficulty, please feel free either to call Andrew or myself to work that out. It would be great, because it would be great to have all images alt tagged in the future. Someone’s just asked can you show us how to structure a box, please? That person meant a text box because text boxes are an issue aren’t they Andrew.
SPEAKER: Text boxes, the funny thing is that Word gives us all these tools to make a document fully accessible but they also give us tools that allow you to make a document that’s completely inaccessible. If you use what Word calls a text box, then screen readers and literacy assistance software won’t know that the text box is there. The beauty of the text box from the designer’s point of view is that you can tow it around the page to where you want it. The disadvantage for people who use assistive technologies is that the assistive technology doesn’t know that it’s there. It can be found with a screen reader if you sort of guessed there must be something missing and you do a lot of browsing around.
DARLENE: Has it an alt text in the back of that at all?
ANDREW: No. Again not -- let me come...
[pause]
are you seeing my text box there?
DARLENE: Yep, we are. So you are doing well.
ANDREW: Yeah, so that is not a text box. That is...
SCREEN READER: Style box. Do not use text boxes. They are...
ANDREW: So that’s its style box. That is the style I’ve given to the paragraph. All I did was to indent it and then put the border around it and then created the style called box. So it is not a text box. I just did it to show you you can make it look like one. It is a proper paragraph. So in answer to the question, if you use a text box it won’t be accessible.
DARLENE: But to do a box you can do it in the paragraph.
ANDREW: Yeah, if you wanted to make it look like this then you just create the paragraph, indent it, you choose whatever font you want, set the indent, set the space before and after and then put the border around it. That’s not the appeal; the appeal of text boxes for people who are writing documents is that they can push it around the page to where they want it to be.
DARLENE: So people are really keen to see how you’ve done that in style, if possible.
ANDREW: What’s the easiest way to do that? If I go to -- yeah I should be able to do that.
[pause]
I’m trying to get the modify style. Oh, there it -- whoops.
DARLENE: Okay, so for people who wanted to check out the chat box while you’re doing that, Andrew, someone’s just kind of put up some ideas on how you actually get to the alt text in the old versions of Word. So thank you for that.
ANDREW: So let me go to new style, I think that’ll do it.
[pause]
Now style 1 is normally, that’s the default that a new style gets given. I’d suggest not doing that. Give it a meaningful name. So it’s a paragraph and it’s based on my box style. So you see I’ve got Helvetica, I’ve got 14 point, I’ve checked bold.
[pause]
I’m just tabbing across. That ‘Automatically update’, I’d normally not check that because if you make a mistake and it updates itself you can be in trouble. And that’s where I’ve got ‘Only in this document’. Here we get to format. So that’s the border and that’s where I put the border around it. So that’s -‑ does that answer the question the person is asking?
DARLENE: Yep, I think, hopefully, that would work.
ANDREW: That’s all I’ve done. Again, just to reiterate, it is not a text box. It’s a normal document.
DARLENE: Yep, that’s brilliant. So probably more of a, you know, a larger question, not necessarily the how to, well it is a how to, is how to support colleagues in creating accessible documents who haven’t considered accessibility before, a lack of awareness or knowledge. This is often what we’re dealing with, you know, with teachers and academics and so forth. Any suggestions of that Andrew?
ANDREW: Yeah, yeah, re-education camp is the solution. Siberia, I think, has ‑ yeah. No, I think ‑- one of the things I’ve tried to convey in this presentation is that once you know how to set up your styles and how to apply them quickly and easily it saves you a huge amount of time and effort. Someone near and dear to me when she was going through uni asked me to check her essays. I kept grumbling that she’s not using proper styles. She said I haven’t got time. I said you’re wasting time. She’s now a high school teacher and gets absolutely livid if students don’t use proper style because eventually the penny dropped. So, yes, it’s important to get people to understand that it’s for their own sake as well as anyone else’s that you are getting them to do it this way. That’s the important bit.
DARLENE: Yep, great, thank you. I don’t know if you’ve answered this Andrew because I was kind of in the middle of doing things. So is it possible to remove styling buttons, e.g. bold, italic, font, size, colour, from MS Word to force authors to use built‑in styles, title, level 1?
ANDREW: Not to my knowledge. You probably don’t want to do it anyway because when you set up your style you may well, particularly for heading styles, you may well want to use bold and so forth. So you may want to use those buttons in the creation or the modification of your style. So I’m not sure that you’d want to do that. As I think ‑ that’s a good idea.
DARLENE: It is a good idea. Let’s put it to Word and get them to put that in the options.
ANDREW: You can only use the styles that I’ve given you.
DARLENE: Well, especially if you are setting up templates -- well I suppose if the template is set up.
ANDREW: You still have all the other -‑ you can modify the ribbon. So it is possible that when you’re setting up the templates you could put all that, a lot of those things out of the ribbon so that people couldn’t get to it. It’s a very nice thought. I like that one.
DARLENE: Yep, excellent. Any final questions for Andrew? I’m reading through. I’ve got three screens here reading through hoping I haven’t missed any. There was the InDesign question but you answered that.
ANDREW: I think I’ve covered that. What I should add is, well, first of all, I have ‑- it’s a bit old now but I do have quite a lot of stuff that I’ve grabbed from Adobe on creating PDFs from InDesign to make it accessible. But I also had a quick look on the Adobe, I did a Google search and went to Adobe, and they’ve got some new material and it looks a little bit like it might be easier than it used to be. But it is more complicated than coming from Word. If you are a person who uses InDesign, then I’d be strongly suggesting that you use a screen reader, NVDA if you wish because it’s free and easy to use, just to make sure that it’s reading the way you want once you’ve created the PDF. In fact, the Adobe material seemed to suggest that there is still some remediation required once you’ve got the PDF done. Which, you know, it all gets a bit heroic.
DARLENE: Yeah, yeah, it does. I mean, but, you know, just that good practice that the reality is if you were giving it off to a designer, you would probably have started in Word anyway to give them the content.
ANDREW: Yeah, but once it goes to InDesign then you lose all that.
DARLENE: Yeah, but if you actually then provide two, if you know if you can’t do that, you can actually provide two documents.
ANDREW: Yes, you could. I missed the name, but someone was, yeah, Ros, was asking about mind mapping tools. I don’t know if it’s just me or whether the screen reader users generally but they don’t work for me at all. It might be my whole thing about alphabetical order and all this sort of stuff. It might be just my concrete thinking. I suspect that mind mapping tools are a fairly visual sort of metaphor. I might be wrong. At least from my perspective they don’t work for me at all. I write things down in a linear fashion. So OneNote, for example, that Troy was demonstrating last week, I’ve never been able to get any joy out of it at all.
DARLENE: Okay, so if any other screen reader users are online and have come across mind maps or apps tools that are accessible please pop it in the chat box.
ANDREW: OneNote is not inaccessible, it’s just more trouble than it’s worth for me to do it.
DARLENE: Yeah, no it’s fine. I think that’s all the questions. So thank you, Andrew. As always, when I talk to you I learn so much. And hopefully people, well people will have picked up some tips and tricks today to making their Word documents and their PDFs far more accessible. The webinar will be available on ADCET. You will receive an email. And as I’ve said we’ve also got some how to videos, little short vignette videos coming that Andrew’s done for us, that you can actually go back into how to create a PDF, how to check your accessibility. So it will actually be all in separate videos too. You know how to alt tag but you don’t know how to check for accessibility, you’ll be able to go to the right video for that. So hopefully they’ll be coming online very quickly.
ANDREW: They’re about five minutes each so you can get through quite quickly. I’ll just finish up with a story I heard some time ago about a tourist who was in New York City. He pulled up a passer-by and said, "Pardon me, how do I get to Carnegie Hall? And the guy said, practice, man, practice”. Go away and practice.
DARLENE: That’s a dad joke I say, that’s a dad joke.
ANDREW: The point is that, you know, go away and practice what we’ve gone through because if you come back to it in six months’ time you’ll have forgotten it whereas if you start putting it into practice it will become second nature.
DARLENE: Definitely, I think it’s that use it or lose it. Someone was texting before saying we must remember to keep using this stuff so that it becomes second nature to us. Just a blatant plug before people do sign off. Our next webinar actually is happening next week on Monday. That’s going to be for ‘Collaboration for improved career development decisions for students with mental health conditions’. So that’s on Monday at 1 o’clock. All the details are on the ADCET website if you’d like to register for that. So thank you everybody for joining us. It’s been a delight to have you all with us today and thank you for your questions and for playing along at home. So go forth and be accessible. Thank you so much, Andrew, for presenting the information today.
ANDREW: Bye all.
DARLENE: Bye.

